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Preface
The AVR128DB48 Curiosity Nano Evaluation Kit is a hardware platform to evaluate microcontrollers in the AVR® DB
Family. This board has the AVR128DB48 microcontroller (MCU) mounted.

Supported by both MPLAB® X IDE and Atmel Studio 7, the board provides easy access to the features of the
AVR128DB48 to explore how to integrate the device into a custom design.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary to
program and debug the AVR128DB48.

• MPLAB® X IDE and Atmel Studio - Software to discover, configure, develop, program, and debug Microchip
microcontrollers.

• Code examples on GitHub - Get started with code examples.
• AVR128DB48 website - Find documentation, data sheets, sample, and purchase microcontrollers.
• AVR128DB48 Curiosity Nano website - Kit information, latest user guide, and design documentation.
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1. Introduction

1.1 Features
• AVR128DB48 Microcontroller
• One Yellow User LED
• One Mechanical User Switch
• One 32.768 kHz Crystal
• One 16.00 MHz Crystal
• On-Board Debugger:

– Board identification in Microchip MPLAB® X IDE and Atmel Studio 7
– One green power and status LED
– Programming and debugging
– Virtual serial port (CDC)
– Two debug GPIO channels (DGI GPIO)

• USB Powered
• Adjustable Target Voltage:

– MIC5353 LDO regulator controlled by the on-board debugger
– 1.8–5.1V output voltage (limited by USB input voltage)
– 500 mA maximum output current (limited by ambient temperature and output voltage)

1.2 Board Overview
The Microchip AVR128DB48 Curiosity Nano Evaluation Kit is a hardware platform to evaluate the AVR128DB48
microcontroller.

Figure 1-1. AVR128DB48 Curiosity Nano Board Overview
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2. Getting Started

2.1 Quick Start
Steps to start exploring the AVR128DB48 Curiosity Nano board:

1. Download Microchip MPLAB® X IDE and MPLAB® XC C Compiler, or download Atmel Studio 7.
2. Launch MPLAB® X IDE or Atmel Studio 7.
3. Optional: Use MPLAB® Code Configurator or Atmel START to generate drivers and examples.
4. Write your application code.
5. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the

board.

Info: 
• MPLAB® X IDE supports XC C compilers and the AVR® and Arm® Toolchains (GCC Compilers)
• Microchip’s XC8 C Compiler supports all 8-bit PIC® and AVR® microcontrollers
• Included in the Atmel Studio 7 download are the AVR® and Arm® Toolchains (GCC Compilers)

2.1.1 Driver Installation

When the board is connected to your computer for the first time, the operating system will perform a driver software
installation. The driver file supports both 32- and 64-bit versions of Microsoft® Windows® XP, Windows Vista®,
Windows 7, Windows 8, and Windows 10. The drivers for the board are included with both MPLAB® X IDE and Atmel
Studio 7.

2.1.2 Kit Window

Once the board is powered, the green status LED will be lit, and both MPLAB® X IDE and Atmel Studio 7 will auto-
detect which boards are connected. The Kit Window in MPLAB® X IDE and Atmel Studio 7 will present relevant
information like data sheets and board documentation. The AVR128DB48 device on the AVR128DB48 Curiosity
Nano board is programmed and debugged by the on-board debugger and, therefore, no external programmer or
debugger tool is required.

Tip:  The Kit Window can be opened in MPLAB® X IDE through the menu bar Window > Kit Window.

2.1.3 MPLAB® X IDE Device Family Packs

Microchip MPLAB® X IDE requires specific information to support devices and tools. This information is contained in
versioned packs. For the AVR128DB48 Curiosity Nano, board MPLAB® X version 5.40 with device family pack “AVR-
Dx_DFP” version 1.2 and tool pack “nEDBG_TP” version 1.1 or newer are required. For more information on packs
and how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work with Device Packs.

Tip:  The latest device family packs are available through Tools > Packs in MPLAB® X IDE or online at 
Microchip MPLAB® X Packs Repository.

 AVR128DB48 Curiosity Nano
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2.1.4 Atmel Studio 7 Device Family Pack
Atmel Studio 7 requires specific information to support devices. This information is contained in versioned packs. For
the AVR128DB48 Curiosity Nano board, Atmel Studio 7 version 7.0.2397 with device family pack “AVR-Dx_DFP”
version 1.1 or newer are required. For more information on packs and how to upgrade them, refer to the Atmel Studio
7 User Guide - Device Pack Manager.

Tip:  The latest device family packs are available through Tools > Device Pack Manager in Atmel Studio 7
or online at Atmel Studio Packs Repository.

2.2 Design Documentation and Relevant Links
The following list contains links to the most relevant documents and software for the AVR128DB48 Curiosity Nano
board:

• MPLAB® X IDE - MPLAB X IDE is a software program that runs on a PC (Windows®, Mac OS®, Linux®) to
develop applications for Microchip microcontrollers and digital signal controllers. It is called an Integrated
Development Environment (IDE) because it provides a single integrated “environment” to develop code for
embedded microcontrollers.

• Atmel Studio - Free IDE for the development of C/C++ and assembler code for microcontrollers.
• IAR Embedded Workbench® for AVR® - This is a commercial C/C++ compiler that is available for AVR

microcontrollers. There is a 30-day evaluation version as well as a 4 KB code-size-limited kick-start version
available from their website.

• MPLAB® XC Compilers - MPLAB® XC8 C Compiler is available as a free, unrestricted-use download.
Microchips MPLAB® XC8 C Compiler is a comprehensive solution for your project’s software development on
Windows®, macOS® or Linux®. MPLAB® XC8 supports all 8-bit PIC® and AVR® microcontrollers (MCUs).

• MPLAB® Code Configurator - MPLAB Code Configurator (MCC) is a free software plug-in that provides a
graphical interface to configure peripherals and functions specific to your application.

• Atmel START - Atmel START is an online tool that hosts code examples, helps the user to select and configure
software components, and tailor your embedded application in a usable and optimized manner.

• Microchip Sample Store - Microchip sample store where you can order samples of devices.
• MPLAB Data Visualizer - MPLAB Data Visualizer is a program used for processing and visualizing data. The

Data Visualizer can receive data from various sources such as serial ports and on-board debugger’s Data
Gateway Interface, as found on Curiosity Nano and Xplained Pro boards.

• Studio Data Visualizer - Studio Data Visualizer is a program used for processing and visualizing data. The
Data Visualizer can receive data from various sources such as serial ports, on-board debugger’s Data Gateway
Interface as found on Curiosity Nano and Xplained Pro boards, and power data from the Power Debugger.

• Microchip PIC® and AVR® Examples - Microchip PIC and AVR Device Examples is a collection of examples
and labs that use Microchip development boards to showcase the use of PIC and AVR device peripherals.

• Microchip PIC® and AVR® Solutions - Microchip PIC and AVR Device Solutions contains complete
applications for use with Microchip development boards, ready to be adapted and extended.

• AVR128DB48 Curiosity Nano website - Kit information, latest user guide, and design documentation.
• AVR128DB48 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.
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3. Preprogrammed Application
The AVR128DB48 mounted on the Curiosity Nano Evaluation Kit is preprogrammed with an application ready to
utilize the integrated operational amplifiers.

To get started with the application, you can find the user guide, code, and hex files for this application available online
on GitHub:

• MPLAB X® IDE
• Atmel Studio 7

 AVR128DB48 Curiosity Nano
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4. Curiosity Nano
Curiosity Nano is an evaluation platform of small boards with access to most of the microcontrollers I/Os. The
platform consists of a series of low pin count microcontroller (MCU) boards with on-board debuggers, which are
integrated with MPLAB® X IDE and Atmel Studio 7. Each board is identified in the IDE. When plugged in, a Kit
Window is displayed with links to key documentation, including relevant user guides, application notes, data sheets,
and example code. Everything is easy to find. The on-board debugger features a virtual serial port (CDC) for serial
communication to a host PC and a Data Gateway Interface (DGI) with debug GPIO pin(s).

4.1 On-Board Debugger Overview
AVR128DB48 Curiosity Nano contains an on-board debugger for programming and debugging. The on-board
debugger is a composite USB device consisting of several interfaces:

• A debugger that can program and debug the AVR128DB48 in both MPLAB® X IDE and Atmel Studio 7
• A mass storage device that allows drag-and-drop programming of the AVR128DB48
• A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter (UART) on the

AVR128DB48, and provides an easy way to communicate with the target application through terminal software
• A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug GPIO) to visualize

program flow

The on-board debugger controls a Power and Status LED (marked PS) on the AVR128DB48 Curiosity Nano Board.
The table below shows how the LED is controlled in different operation modes.

Table 4-1. On-Board Debugger LED Control

Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up

Power-up The LED is ON

Normal operation The LED is ON

Programming Activity indicator: The LED blinks slowly during programming/debugging

Drag-and-drop
programming Success: The LED blinks slowly for 2 sec

Failure: The LED blinks rapidly for 2 sec

Fault The LED blinks rapidly if a power fault is detected

Sleep/Off The LED is OFF. The on-board debugger is either in a sleep mode or powered down.
This can occur if the board is externally powered.

Info:  Slow blinking is approximately 1 Hz, and rapid blinking is approximately 5 Hz.

4.1.1 Debugger
The on-board debugger on the AVR128DB48 Curiosity Nano Board appears as a Human Interface Device (HID) on
the host computer’s USB subsystem. The debugger supports full-featured programming and debugging of the
AVR128DB48 using both MPLAB® X IDE and Atmel Studio 7, as well as some third-party IDEs.

 AVR128DB48 Curiosity Nano
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Remember:  Keep the debugger’s firmware up-to-date. Firmware upgrades are done automatically when
using MPLAB® X IDE or Atmel Studio 7.

4.1.2 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target device.

4.1.2.1 Overview
The on-board debugger implements a composite USB device that includes a standard Communications Device Class
(CDC) interface, which appears on the host as a virtual serial port. The CDC can be used to stream arbitrary data in
both directions between the host computer and the target: All characters sent through the virtual serial port on the
host computer will be transmitted as UART on the debugger’s CDC TX pin, and UART characters captured on the
debugger’s CDC RX pin will be returned to the host computer through the virtual serial port.

Figure 4-1. CDC Connection
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Info:  As shown in Figure 4-1, the debugger’s CDC TX pin is connected to a UART RX pin on the target
for receiving characters from the host computer. Similarly, the debugger’s CDC RX pin is connected to a
UART TX pin on the target for transmitting characters to the host computer.

4.1.2.2 Operating System Support
On Windows machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the Ports section of the
Windows Device Manager. The COM port number can also be found there.

Info:  On older Windows systems, a USB driver is required for CDC. This driver is included in installations
of both MPLAB® X IDE and Atmel Studio 7.

On Linux machines, the CDC will enumerate and appear as /dev/ttyACM#.

Info:  tty* devices belong to the “dialout” group in Linux, so it may be necessary to become a member of
that group to have permissions to access the CDC.

On MAC machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on which terminal
program is used, it will appear in the available list of modems as usbmodem#.

 AVR128DB48 Curiosity Nano
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Info:  For all operating systems: Be sure to use a terminal emulator that supports DTR signaling. See 
4.1.2.4  Signaling.

4.1.2.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined here:

• Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be set to the
closest limit, without warning. Baud rate can be changed on-the-fly.

• Character format: Only 8-bit characters are supported.
• Parity: Can be odd, even, or none.
• Hardware flow control: Not supported.
• Stop bits: One or two bits are supported.

4.1.2.4 Signaling
During USB enumeration, the host OS will start both communication and data pipes of the CDC interface. At this
point, it is possible to set and read back the baud rate and other UART parameters of the CDC, but data sending and
receiving will not be enabled.

When a terminal connects on the host, it must assert the DTR signal. As this is a virtual control signal implemented
on the USB interface, it is not physically present on the board. Asserting the DTR signal from the host will indicate to
the on-board debugger that a CDC session is active. The debugger will then enable its level shifters (if available), and
start the CDC data send and receive mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
• Debugger UART receiver is disabled, so no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send data that is queued for sending, but no new data is accepted

from the host computer
• Level shifters (if available) are not disabled, so the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
• Debugger UART receiver is disabled, so no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send data that is queued for sending, but no new data is accepted

from the host computer
• Once the ongoing transmission is complete, level shifters (if available) are disabled, so the debugger CDC TX

line will become high-impedance

Remember:  Set up the terminal emulator to assert the DTR signal. Without the signal, the on-board
debugger will not send or receive any data through its UART.

Tip:  The on-board debugger’s CDC TX pin will not be driven until the CDC interface is enabled by the
host computer. Also, there are no external pull-up resistors on the CDC lines connecting the debugger and
the target, which means that during power-up, these lines are floating. To avoid any glitches resulting in
unpredictable behavior like framing errors, the target device should enable the internal pull-up resistor on
the pin connected to the debugger’s CDC TX pin.

 AVR128DB48 Curiosity Nano
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4.1.2.5 Advanced Use

CDC Override Mode
In normal operation, the on-board debugger is a true UART bridge between the host and the device. However, in
certain use cases, the on-board debugger can override the basic operating mode and use the CDC TX and RX pins
for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters out of the
debugger’s CDC TX pin. The filename and extension are trivial, but the text file must start with the characters:
CMD:SEND_UART=

Debugger firmware version 1.20 or earlier has the following limitations:
• The maximum message length is 50 characters – all remaining data in the frame are ignored
• The default baud rate used in this mode is 9600 bps, but if the CDC is already active or has been configured,

the previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
• The maximum message length may vary depending on the MSC/SCSI layer timeouts on the host computer

and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload) is guaranteed, and files
of up to 4 KB will work on most systems. The transfer will complete on the first NULL character encountered in
the file.

• The baud rate used is always 9600 bps for the default command:
CMD:SEND_UART=

The CDC Override Mode should not be used simultaneously with data transfer over CDC/terminal. If a CDC
terminal session is active at the time a file is received via CDC Override Mode, it will be suspended for the
duration of the operation and resumed once complete.

• Additional commands are supported with explicit baud rates:
CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB-Level Framing Considerations
Sending data from the host to the CDC can be done byte-wise or in blocks, which will be chunked into 64-byte USB
frames. Each such frame will be queued up for sending to the debugger’s CDC TX pin. Transferring a small amount
of data per frame can be inefficient, particularly at low baud rates, as the on-board debugger buffers frames and not
bytes. A maximum of four 64-byte frames can be active at any time. The on-board debugger will throttle the incoming
frames accordingly. Sending full 64-byte frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the incoming bytes into
64-byte frames, which are sent to the USB queue for transmission to the host when they are full. Incomplete frames
are also pushed to the USB queue at approximately 100 ms intervals, triggered by USB start-of-frame tokens. Up to
eight 64-byte frames can be active at any time.

If the host (or the software running on it) fails to receive data fast enough, an overrun will occur. When this happens,
the last-filled buffer frame will be recycled instead of being sent to the USB queue, and a full frame of data will be
lost. To prevent this occurrence, the user must ensure that the CDC data pipe is being read continuously, or the
incoming data rate must be reduced.

4.1.3 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible for read/write
operations via the host operating system to which it is connected.

It provides:
• Read access to basic text and HTML files for detailed kit information and support

 AVR128DB48 Curiosity Nano
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• Write access for programming Intel® HEX formatted files into the target device’s memory
• Write access for simple text files for utility purposes

4.1.3.1 Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system that has several limitations,
partly due to the nature of FAT12 itself and optimizations made to fulfill its purpose for its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does not, in any way, fulfill
the expectations of a general purpose mass storage device. This behavior is intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano USB Device
that can be found in the disk drives section of the device manager. The CURIOSITY drive appears in the file manager
and claims the next available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space. This does not reflect the size of the target
device’s Flash in any way. When programming an Intel® HEX file, the binary data are encoded in ASCII with
metadata providing a large overhead, so one MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. When programming a file to the target, the filename may appear in
the disk directory listing. This is merely the operating system’s view of the directory, which, in reality, has not been
updated. It is not possible to read out the file contents. Removing and replugging the board will return the file system
to its original state, but the target will still contain the application that has been previously programmed.

To erase the target device, copy a text file starting with “CMD:ERASE” onto the disk.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as reporting status and
linking to further information:

• AUTORUN.ICO – icon file for the Microchip logo
• AUTORUN.INF – system file required for Windows Explorer to show the icon file
• KIT-INFO.HTM – redirect to the development board website
• KIT-INFO.TXT – a text file containing details about the board’s debugger firmware version, board name, USB

serial number, device, and drag-and-drop support
• STATUS.TXT – a text file containing the programming status of the board

Info:  STATUS.TXT is dynamically updated by the on-board debugger. The contents may be cached by
the OS and, therefore, do not reflect the correct status.

4.1.3.2 Limitations of Drag-and-Drop Programming

Lock Bits
Lock bits included in the hex file will be ignored when using drag-and-drop programming. To program lock bits, use
MPLAB® X IDE or Atmel Studio 7.

Enabling CRC Check in Fuses
It is not advisable to enable the CRC check in the target device’s fuses when using drag-and-drop programming. This
is because a subsequent chip erase (which does not affect fuse bits) will effect a CRC mismatch, and the application
will fail to boot. To recover a target from this state, a chip erase must be done using MPLAB® X IDE or
Atmel Studio 7, which will automatically clear the CRC fuses after erasing.

4.1.3.3 Special Commands
Several utility commands are supported by copying text files to the mass storage disk. The filename or extension is
irrelevant – the command handler reacts to content only.
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Table 4-2. Special File Commands

Command Content Description

CMD:ERASE Executes a chip erase of the target

CMD:SEND_UART= Sends a string of characters to the CDC UART. See “CDC
Override Mode”.

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

Sends a string of characters to the CDC UART at the baud rate
specified. Note that only the baud rates explicitly specified here
are supported! See “CDC Override Mode” (Debugger firmware
v1.21 or newer.)

CMD:RESET Resets the target device by entering Programming mode and
then exiting Programming mode immediately thereafter. Exact
timing can vary according to the programming interface of the
target device. (Debugger firmware v1.16 or newer.)

CMD:POWERTOGGLE Powers down the target and restores power after a 100 ms
delay. If external power is provided, this has no effect.
(Debugger firmware v1.16 or newer.)

CMD:0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect.
(Debugger firmware v1.16 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided,
this has no effect. (Debugger firmware v1.21 or newer.)

CMD:3V3 Sets the target voltage to 3.3V. If external power is provided,
this has no effect. (Debugger firmware v1.16 or newer.)

CMD:5V0 Sets the target voltage to 5.0V. If external power is provided,
this has no effect. (Debugger firmware v1.16 or newer.)

Info:  The commands listed here are triggered by the content being sent to the mass storage emulated
disk, and no feedback is provided in the case of either success or failure.

4.1.4 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface for transporting raw and timestamped data between on-board
debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on the host computer to
display debug GPIO data. It is available as a plug-in for MPLAB® X IDE or a stand-alone application that can be used
in parallel with MPLAB® X IDE or Atmel Studio 7.

Although DGI encompasses several physical data interfaces, the AVR128DB48 Curiosity Nano implementation
includes logic analyzer channels:

• Two debug GPIO channels (also known as DGI GPIO)

4.1.4.1 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a host computer
visualization application. They are typically used to plot the occurrence of low-frequency events on a time-axis – for
example, when certain application state transitions occur.

The figure below shows the monitoring of the digital state of a mechanical switch connected to a debug GPIO in
MPLAB Data Visualizer.
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Figure 4-2. Monitoring Debug GPIO with MPLAB® Data Visualizer

Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the resolution of the
DGI timestamp module.

Important:  Although bursts of higher-frequency signals can be captured, the useful frequency range of
signals for which debug GPIO can be used is up to about 2 kHz. Attempting to capture signals above this
frequency will result in data saturation and overflow, which may cause the DGI session to be aborted.

4.1.4.2 Timestamping
DGI sources are timestamped as they are captured by the debugger. The timestamp counter implemented in the
Curiosity Nano debugger increments at 2 MHz frequency, providing a timestamp resolution of a half microsecond.

4.2 Curiosity Nano Standard Pinout
The 12 edge connections closest to the USB connector on Curiosity Nano boards have a standardized pinout. The
program/debug pins have different functions depending on the target programming interface, as shown in the table
and figure below.

Table 4-3. Curiosity Nano Standard Pinout

Debugger Signal Target MCU Description

ID — ID line for extensions

CDC TX UART RX USB CDC TX line

CDC RX UART TX USB CDC RX line

DBG0 UPDI Debug data line

DBG1 GPIO1 debug GPIO1

DBG2 GPIO0 debug GPIO0

DBG3 RESET Reset line

NC — No connect
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...........continued
Debugger Signal Target MCU Description

VBUS — VBUS voltage for external use

VOFF — Voltage Off input. Disables the target regulator and
target voltage when pulled low.

VTG — Target voltage

GND — Common ground

Figure 4-3. Curiosity Nano Standard Pinout
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4.3 Power Supply
The board is powered through the USB port and contains two LDO regulators, one to generate 3.3V for the on-board
debugger, and an adjustable LDO regulator for the target microcontroller AVR128DB48 and its peripherals. The
voltage from the USB connector can vary between 4.4V to 5.25V (according to the USB specification) and will limit
the maximum voltage to the target. The figure below shows the entire power supply system on AVR128DB48
Curiosity Nano.

Figure 4-4. Power Supply Block Diagram
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4.3.1 Target Regulator
The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust the voltage output
supplied to the board target section by manipulating the MIC5353’s feedback voltage. The hardware implementation
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is limited to an approximate voltage range from 1.7V to 5.1V. Additional output voltage limits are configured in the
debugger firmware to ensure that the output voltage never exceeds the hardware limits of the AVR128DB48
microcontroller. The voltage limits configured in the on-board debugger on AVR128DB48 Curiosity Nano are 1.8–
5.5V.

Info:  The target voltage is set to 3.3V when the board is manufactured. It can be changed through
MPLAB® X IDE project properties and in the Atmel Studio 7 device programming dialog. Any change to
the target voltage is persistent, even after a power toggle. The resolution is less than 5 mV but may be
limited to 10 mV by the adjustment program.

Info:  Voltage settings that are set up in MPLAB® X IDE are not immediately applied to the board. The
new voltage setting is applied to the board when the debugger is accessed in any way, like pushing the
Refresh Debug Tool Status button in the project dashboard tab, or programming/reading program memory.

Info:  There is a simple option to adjust the target voltage with a drag-and-drop command text file to the
board. This supports a set of common target voltages. See section 4.1.3.3  Special Commands for further
details.

The MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package, placed on a
small printed circuit board (PCB), and the thermal shutdown condition can be reached at lower loads than 500 mA.
The maximum current load depends on the input voltage, the selected output voltage, and the ambient temperature.
The figure below shows the safe operating area for the regulator, with an input voltage of 5.1V and an ambient
temperature of 23°C.

Figure 4-5. Target Regulator Safe Operation Area

The voltage output of the target regulator is continuously monitored (measured) by the on-board debugger. If it is
more than 100 mV over/under the voltage setting value, an error condition will be flagged, and the target voltage
regulator will be turned off. This will detect and handle any short-circuit conditions. It will also detect and handle if an
external voltage, which causes VCC_TARGET to move outside of the voltage setting monitoring window of ±100 mV,
is suddenly applied to the VTG pin, without setting the VOFF pin low.
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Info:  If the external voltage is lower than the monitoring window lower limit (target voltage setting – 100
mV), the on-board debugger status LED will blink rapidly. If the external voltage is higher than the
monitoring window upper limit (target voltage setting + 100 mV), the on-board debugger status LED will
continue to shine. If the external voltage is removed, the status LED will start to blink rapidly until the on-
board debugger detects the new situation and turns the target voltage regulator back on.

4.3.2 External Supply
AVR128DB48 Curiosity Nano can be powered by an external voltage instead of the on-board target regulator. When
the Voltage Off (VOFF) pin is shorted to ground (GND), the on-board debugger firmware disables the target regulator,
and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the DEBUG connector
on the board.

The VOFF pin can be tied low/let go at any time. This will be detected by a pin-change interrupt to the on-board
debugger, which controls the target voltage regulator accordingly.

WARNING
Applying an external voltage to the VTG pin without shorting VOFF to GND may cause permanent damage
to the board.

WARNING
Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

WARNING
Absolute maximum external voltage is 5.5V for the on-board level shifters, and the standard operating
condition of the AVR128DB48 is 1.8–5.5V. Applying a higher voltage may cause permanent damage to the
board.

Info:  If an external voltage is applied without pulling the VOFF pin low and an external supply pulls the
voltage lower than the monitoring window’s lower limit (target voltage setting - 100 mV), the on-board
debugger status LED will blink rapidly and shut the on-board regulator off. If an external voltage is
suddenly removed when the VOFF pin is not pulled low, the status LED will start to blink rapidly, until the
on-board debugger detects the new situation and switches the target voltage regulator back on.

Programming, debugging, and data streaming is still possible with an external power supply – the debugger and
signal level shifters will be powered from the USB cable. Both regulators, the debugger and the level shifters are
powered down when the USB cable is removed.

Info:  In addition to the power consumed by the AVR128DB48 and its peripherals, approximately 100 µA
will be drawn from any external power source to power the on-board level shifters and voltage monitor
circuitry when a USB cable is plugged in the DEBUG connector on the board. When a USB cable is not
plugged in, some current is used to supply the level shifters voltage pins, which have a worst-case current
consumption of approximately 5 µA. Typical values may be as low as 100 nA.

4.3.3 VBUS Output Pin
AVR128DB48 Curiosity Nano has a VBUS output pin that can be used to power external components that need a 5V
supply. The VBUS output pin has a PTC fuse to protect the USB against short circuits. A side effect of the PTC fuse
is a voltage drop on the VBUS output with higher current loads. The chart below shows the voltage versus the current
load of the VBUS output.
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Figure 4-6. VBUS Output Voltage vs. Current

4.3.4 Power Supply Exceptions
This is a summary of most exceptions that can occur with the power supply.

Target Voltage Shuts Down
This can happen if the target section draws too much current at a given voltage. This will cause the thermal shutdown
safety feature of the MIC5353 regulator to kick in. To avoid this, reduce the current load of the target section.

Target Voltage Setting is Not Reached
The maximum output voltage is limited by the USB input voltage (specified to be 4.4-5.25V), and the voltage drop
over the MIC5353 regulator at a given voltage setting and current consumption. If a higher output voltage is needed,
use a USB power source that can provide a higher input voltage or use an external voltage supply on the VTG pin.

Target Voltage is Different From Setting
This can be caused by an externally applied voltage to the VTG pin, without setting the VOFF pin low. If the target
voltage differs more than 100 mV over/under the voltage setting, it will be detected by the on-board debugger, and
the internal voltage regulator will be shut down. To fix this issue, remove the applied voltage from the VTG pin, and
the on-board debugger will enable the on-board voltage regulator when the new condition is detected. Note that the
PS LED will be blinking rapidly if the target voltage is below 100 mV of the setting, but will be lit normally when it is
higher than 100 mV above the setting.

No, Or Very Low Target Voltage, and PS LED is Blinking Rapidly
This can be caused by a full or partial short-circuit and is a special case of the issue mentioned above. Remove the
short-circuit, and the on-board debugger will re-enable the on-board target voltage regulator.
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No Target Voltage and PS LED is Lit 1
This occurs if the target voltage is set to 0.0V. To fix this, set the target voltage to a value within the specified voltage
range for the target device.

No Target Voltage and PS LED is Lit 2
This can be the issue if power jumper J100 and/or J101 is cut, and the target voltage regulator is set to a value within
the specified voltage range for the target device. To fix this, solder a wire/bridge between the pads for J100/J101, or
add a jumper on J101 if a pin header is mounted.

VBUS Output Voltage is Low or Not Present
This is most lightly caused by a high-current drain on VBUS, and the protection fuse (PTC) will reduce the current or
cut off completely. Reduce the current consumption on the VBUS pin to fix this issue.

4.4 Low-Power Measurement
Power to the AVR128DB48 is connected from the on-board power supply and VTG pin through a 100 mil pin header
marked with “POWER” in silkscreen (J101). To measure the power consumption of the AVR128DB48 and other
peripherals connected to the board, cut the Target Power strap and connect an ammeter over the strap.

To measure the lowest possible power consumption follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin header in the footprint.
3. Connect an ammeter to the pin header.
4. Write firmware that:

4.1. Tri-states any I/O connected to the on-board debugger.
4.2. Sets the microcontroller in its lowest power Sleep state.

5. Program the firmware into the AVR128DB48.

Figure 4-7. Target Power Strap

Target Power strap (top side)
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Tip:  A 100-mil pin header can be soldered into the Target Power strap (J101) footprint for easy
connection of an ammeter. Once the ammeter is no longer needed, place a jumper cap on the pin header.

Info:  The on-board level shifters will draw a small amount of current even when they are not in use. A
maximum of 2 µA can be drawn from each I/O pin connected to a level shifter for a total of 10 µA. Keep
any I/O pin connected to a level shifter in tri-state to prevent leakage. All I/Os connected to the on-board
debugger are listed in 5.2.5.1  On-Board Debugger Connections. To prevent any leakage to the on-board
level shifters, they can be disconnected completely, as described in 8.4  Disconnecting the On-board
Debugger.

4.5 Programming External Microcontrollers
The on-board debugger on AVR128DB48 Curiosity Nano can be used to program and debug microcontrollers on
external hardware.

4.5.1 Supported Devices
All external AVR microcontrollers with the UPDI interface can be programmed and debugged with the on-board
debugger with Atmel Studio.

External SAM microcontrollers that have a Curiosity Nano Board can be programmed and debugged with the on-
board debugger with Atmel Studio.

AVR128DB48 Curiosity Nano can program and debug external AVR128DB48 microcontrollers with MPLAB X IDE.

4.5.2 Software Configuration
No software configuration is required to program and debug the same device that is mounted on the board.

To program and debug a different microcontroller than what is mounted on the board, Atmel Studio must be
configured to allow free selection of devices and programming interfaces.

1. Navigate to Tools > Options through the menu system at the top of the application.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.
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Figure 4-8. Hide Unsupported Devices

Info:  Atmel Studio allows any microcontroller and interface to be selected when Hide unsupported
devices is set to False, also microcontrollers and interfaces which are not supported by the on-board
debugger.

4.5.3 Hardware Modifications
The on-board debugger is connected to the AVR128DB48 by default. These connections must be removed before
any external microcontroller can be programmed or debugged. Cut the GPIO straps shown in the figure below with a
sharp tool to disconnect the AVR128DB48 from the on-board debugger.
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Figure 4-9. Programming and Debugging Connections to Debugger

GPIO straps (bottom side)

Info:  Cutting the connections to the debugger will disable programming, debugging, and data streaming
from the AVR128DB48 mounted on the board.

Tip:  Solder in 0Ω resistors across the footprints or short-circuit them with solder to reconnect the signals
between the on-board debugger and the AVR128DB48.

4.5.4 Connecting to External Microcontrollers
The figure and table below show where the programming and debugging signals must be connected to program and
debug external microcontrollers. The on-board debugger can supply power to the external hardware, or use an
external voltage as a reference for its level shifters. Read more about the power supply in 4.3  Power Supply.

The on-board debugger and level shifters actively drive data and clock signals (DBG0, DBG1, and DBG2) used for
programming and debugging, and in most cases, the external resistor on these signals can be ignored. Pull-down
resistors are required on the ICSP™ data and clock signals to debug PIC® microcontrollers.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

AVR128DB48 Curiosity Nano has a pull-up resistor, R200, connected to its #RESET signal (DBG3). The location of
the pull-up resistor is shown in the 8.2  Assembly Drawing in the appendix.

Remember: 
• Connect GND and VTG to the external microcontroller
• Tie the VOFF pin to GND if the external hardware has its own power supply
• Make sure there are pull-down resistors on the ICSP data and clock signals (DBG0 and DBG1) to

support the debugging of PIC microcontrollers
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Figure 4-10. Curiosity Nano Standard Pinout
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Table 4-4. Programming and Debugging Interfaces

Curiosity Nano Pin UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — #MCLR #RESET

4.6 Connecting External Debuggers
Even though there is an on-board debugger, external debuggers can be connected directly to the AVR128DB48
Curiosity Nano to program/debug the AVR128DB48. The on-board debugger keeps all the pins connected to the
AVR128DB48 and board edge in tri-state when not actively used. Therefore, the on-board debugger will not interfere
with any external debug tools.
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Figure 4-11. Connecting the MPLAB® PICkit™ 4 In-Circuit Debugger/Programmer to AVR128DB48 Curiosity
Nano
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Figure 4-12. Connecting the Atmel-ICE to AVR128DB48 Curiosity Nano
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CAUTION
To avoid contention between the external debugger and the on-board debugger, do not start any
programming/debug operation with the on-board debugger through MPLAB® X IDE or Atmel Studio 7 or
mass storage programming while the external tool is active.
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5. Hardware User Guide

5.1 Connectors

5.1.1 AVR128DB48 Curiosity Nano Pinout
All the AVR128DB48 I/O pins are accessible at the edge connectors on the board. The image below shows the board
pinout. For all available functions on each pin, refer to the I/O Multiplexing and Considerations section in the
AVR128DB48 data sheet.

Figure 5-1. AVR128DB48 Curiosity Nano Pinout
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5.1.2 Using Pin Headers
The edge connector footprint on AVR128DB48 Curiosity Nano has a staggered design where each hole is shifted 8
mil (~0.2 mm) off-center. The hole shift allows the use of regular 100 mil pin headers on the board without soldering.
Once the pin headers are firmly in place, they can be used in normal applications like pin sockets and prototyping
boards without any issues.
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Figure 5-2. Attaching Pin-Headers to the Curiostiy Nano Board

Figure 5-3. Connecting to Curiosity Nano Base for Click boards™

Tip:  Start at one end of the pin header and gradually insert the header along the length of the board.
Once all the pins are in place, use a flat surface to push them in.

Tip:  For applications where the pin headers will be used permanently, it is still recommended to solder
them in place.

Important:  Once the pin headers are in place, they are hard to remove by hand. Use a set of pliers and
carefully remove the pin headers to avoid damage to the pin headers and PCB.

5.1.3 Multi-Voltage I/O

The AVR128DB48 Curiosity Nano MCU has support for Multi-Voltage I/O (MVIO). AVR128DB48 MVIO pins are
connected to the edge connector at PC0-PC7. MVIO pins are capable of regular I/O-pin behavior.

MVIO can be configured in one of two supply modes:
• Single-Supply mode: All I/O pins, including MVIO-capable pins, are powered by VCC_TARGET. By default,

VCC_TARGET is connected to VDDIO2 through a 0-ohm resistor (R204).
• Dual-Supply mode: MVIO-capable pins are powered by an external power supply connected to VDDIO2. Non-

MVIO pins are powered by VCC_TARGET.

Dual-Supply mode allows MVIO-pins to be powered at different voltages than pins powered from VCC_TARGET.

 AVR128DB48 Curiosity Nano
Hardware User Guide

© 2020 Microchip Technology Inc.  User Guide DS50003037A-page 27



WARNING
The absolute maximum external voltage range for the AVR128DB48 is 1.8–5.5V. Applying a higher voltage
may cause permanent damage to the board.

By default AVR128DB48 Curiosity Nano board is configured for single-supply mode. To use Dual-Supply mode some
hardware modifications are required.

WARNING
Before any hardware modifications are done, make sure the board is disconnected from USB or external
power.

• Disconnect resistor R204 connecting VDDIO2 to VCC_TARGET
• Connect a new power supply to VDDIO2 and ground at J212
• J212 does not have reverse polarity protection. Make sure to match polarity between the power supply and

J212. Positive-polarity to J212-pin 1 and negative-polarity to J212-pin 2

The resistor R204, VDDIO2 and J212 can be seen in Figure 5-4.

Figure 5-4. MVIO and VDDIO2 Connections

J212 R204

WARNING
Applying an external voltage to VDDIO2 pin without removing resistor R204 may cause permanent
damage to the board.

WARNING
J212 does not have reverse polarity protection. Applying voltage to the wrong pin may cause permanent
damage to the board.

5.1.4 Operational Amplifiers
AVR128DB48 features three internal operational amplifiers with a flexible connection scheme using analog
multiplexers and resistor ladders. This allows a large number of analog signal conditioning configurations, many
requiring no external components.

Table 5-1. OPAMP Pin Connections

OPAMP Poisitive Input (INP) Negative Input (INN) Output (OUT)

OP0 PD1 PD3 PD2

OP1 PD4 PD7 PD5
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...........continued
OPAMP Poisitive Input (INP) Negative Input (INN) Output (OUT)

OP2 PE1 PE3 PE2

For information about OPAMP on the edge connector and any shared functionality, see 5.1.1  AVR128DB48 Curiosity
Nano Pinout.

5.2 Peripherals

5.2.1 LED
There is one yellow user LED available on the AVR128DB48 Curiosity Nano board that can be controlled by either
GPIO or PWM. The LED can be activated by driving the connected I/O line to GND.

Table 5-2. LED Connection

AVR128DB48 Pin Function Shared Functionality

PB3 Yellow LED0 Edge connector, On-board debugger

5.2.2 Mechanical Switch
The AVR128DB48 Curiosity Nano board has one mechanical switch. This is a generic user-configurable switch.
When the switch is pressed, it will drive the I/O line to ground (GND).

Tip:  There is no externally connected pull-up resistor on the switch. To use the switch, make sure that an
internal pull-up resistor is enabled on pin PB2.

Table 5-3. Mechanical Switch

AVR128DB48 Pin Description Shared Functionality

PB2 User switch (SW0) Edge connector, On-board debugger

5.2.3 32.768 kHz Crystal

On the AVR128DB48 Curiosity Nano board is a mounted 32.768 kHz crystal of type VMK3-9001-32K7680000, the
crystal is accurate to within 20 ppm. Using the External 32.768 kHz Crystal Oscillator (XOSC32K) module in
AVR128DB48 with the mounted 32.768 kHz crystal generates a clock signal that is significantly more accurate than
the Internal 32.768 kHz Ultra Low-Power Oscillator (OSC32K) module can generate alone. With the Auto-Tune
feature, the 32.768 kHz can be used as a reference to improve the accuracy of the internal oscillator. This is an ideal
reference clock for the Real-Time Counter module in AVR128DB48.

The 32.768 kHz crystal is connected to AVR128DB48 on PF0 and PF1, which are also routed to the edge connector
through two solder points. PF0 and PF1 are disconnected from the edge connector by default to reduce the chance
of an external signal causing contention with the crystal, and to remove excessive capacitance on the lines.

Next to the 32.768 kHz crystal is a cut-strap (J209), which can be used to measure the oscillator safety factor. This is
done by cutting the strap and adding a 0402 SMD resistor across the strap. More information about oscillator
allowance and safety factor can be found in the AN2648 application note from Microchip.

Cut straps and solder points can be seen in Figure 5-5.

Table 5-4. 32.768 kHz Crystal Connections

AVR128DB48 Pin Function Shared Functionality

PF0 XTAL32K1 (Crystal input) Edge connector
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...........continued
AVR128DB48 Pin Function Shared Functionality

PF1 XTAL32K2 (Crystal output) Edge connector

PA0 and PA1 can be used as GPIO. To do so, some hardware modifications are required.

WARNING
Before any hardware modifications are done, make sure the board is disconnected from the USB or
external power.

• Disconnect the 32.768 kHz crystal by cutting the two straps on the top side of the board next to the crystal
(J207, J208). The crystal should be disconnected when using the pin as GPIO, as this might harm the crystal.

• Connect the I/O lines to the edge connector by placing solder blobs on the circular solder points marked PF0
and PF1 on the bottom side of the board (J210, J211)

Figure 5-5. Crystal Connection and Cut Straps

Top side Bo�om side

J211

J210

J207

J20832.768 kHz 
Crystal

J209

5.2.4 16.00 MHz Crystal

On the AVR128DB48 Curiosity Nano board is a mounted 16.00 MHz crystal of type VXM7-9040-16M0000000, the
crystal is accurate to within 20 ppm. Using the External High-Frequency Crystal Oscillator (XOSCHF) module in
AVR128DB48 with the mounted 16.00 MHz crystal generates a clock signal that is significantly more accurate than
the Internal High-Frequency Oscillator (OSCHF) module.

The 16.00 MHz crystal is connected to AVR128DB48 on PA0 and PA1, which are also routed to the edge connector
through two solder points. PA0 and PA1 are disconnected from the edge connector by default to reduce the chance
of an external signal causing contention with the crystal, and to remove excessive capacitance on the lines.

Next to the 16.00 MHz crystal is a cut-strap (J217), which can be used to measure the oscillator safety factor. This is
done by cutting the strap and adding a 0402 SMD resistor across the strap. More information about oscillator
allowance and safety factor can be found in the AN2648 application note from Microchip.

Cut straps and solder points can be seen in Figure 5-6.

Table 5-5. Crystal Connections

AVR128DB48 Pin Function Shared Functionality

PA0 XTALHF1 (Crystal input) Edge connector

PA1 XTALHF2 (Crystal output) Edge connector

PA0 and PA1 can be used as GPIO. To do so, some hardware modifications are required.
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WARNING
Before any hardware modifications are done, make sure the board is disconnected from USB or external
power.

• Disconnect the 16.00 MHz crystal by cutting the two straps on the top side of the board next to the crystal (J215,
J216). The crystal should be disconnected when using the pin as GPIO, as this might harm the crystal.

• Connect the I/O lines to the edge connector by placing solder blobs on the circular solder points marked PA0
and PA1 on the bottom side of the board (J213, J214)

Figure 5-6. Crystal Connection and Cut Straps

Top side Bo�om side

J214

J213

J216

J21516.00 MHz
Crystal

J217

5.2.5 On-Board Debugger Implementation
AVR128DB48 Curiosity Nano features an on-board debugger that can be used to program and debug the
AVR128DB48 using UPDI. The on-board debugger also includes a virtual serial port (CDC) interface over UART and
debug GPIO. Both MPLAB® X IDE and Atmel Studio 7 can be used as a front-end for the on-board debugger for
programming and debugging. MPLAB Data Visualizer can be used as a front-end for the CDC and debug GPIO.

5.2.5.1 On-Board Debugger Connections
The table below shows the connections between the target and the debugger section. All connections between the
target and the debugger are tri-stated as long as the debugger is not actively using the interface. Hence, since there
are little contaminations of the signals, the pins can be configured to anything the user wants.

For further information on how to use the capabilities of the on-board debugger, see 4.1  On-Board Debugger
Overview.

Table 5-6. On-Board Debugger Connections

AVR128DB48
Pin

Debugger Pin Function Shared Functionality

PB1 CDC TX UART RX (AVR128DB48 RX line) Edge connector

PB0 CDC RX UART TX (AVR128DB48 TX line) Edge connector

UPDI DBG0 UPDI Edge connector

PB3 DBG1 LED0/Debug GPIO1 Edge connector

PB2 DBG2 SW0/Debug GPIO0 Edge connector

PF6 DBG3 RESET Edge connector
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6. Hardware Revision History and Known Issues
This user guide is written to provide information about the latest available revision of the board. The following
sections contain information about known issues, a revision history of older revisions, and how older revisions differ
from the latest revision.

6.1 Identifying Product ID and Revision
The revision and product identifier of the AVR128DB48 Curiosity Nano Board can be found in two ways: Either by
utilizing the MPLAB® X IDE or Atmel Studio 7 Kit Window or by looking at the sticker on the bottom side of the PCB.

By connecting AVR128DB48 Curiosity Nano to a computer with MPLAB® X IDE or Atmel Studio 7 running, the Kit
Window will pop up. The first six digits of the serial number, which is listed under kit information, contain the product
identifier and revision.

Tip:  The Kit Window can be opened in MPLAB® X IDE through the menu bar Window > Kit Window.

The same information can be found on the sticker on the bottom side of the PCB. Most boards will have the identifier
and revision printed in plain text as A09-nnnn\rr, where “nnnn” is the identifier, and “rr” is the revision. Boards with
limited space have a sticker with only a data matrix code, containing the product identifier, revision, and serial
number.

The serial number string has the following format:

"nnnnrrssssssssss"

n = product identifier

r = revision

s = serial number

The product identifier for AVR128DB48 Curiosity Nano is A09‑3372.

6.2 Revision 3
AVR128DB48 silicon revision A5 or later is mounted on this revision of the board.

6.3 Revision 2
Revision 2 is the initially released board revision.

AVR128DB48 silicon revision A4 is mounted on this revision of the board.
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7. Document Revision History
Doc. Rev. Date Comments

A 09/2020 Initial document release
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8. Appendix

8.1 Schematic
Figure 8-1. AVR128DB48 Curiosity Nano Schematic
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8.2 Assembly Drawing
Figure 8-2. AVR128DB48 Curiosity Nano Assembly Drawing Top
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8.3 Curiosity Nano Base for Click boards™

Figure 8-4. AVR128DB48 Curiosity Nano Pinout Mapping
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8.4 Disconnecting the On-board Debugger
The on-board debugger and level shifters can be completely disconnected from the AVR128DB48.

The block diagram below shows all connections between the debugger and the AVR128DB48. The rounded boxes
represent connections to the board edge. The signal names shown are also printed in silkscreen on the bottom side
of the board.

To disconnect the debugger, cut the straps shown in Figure 8-6.

Attention:  Cutting the GPIO straps to the on-board debugger will disable the virtual serial port,
programming, debugging, and data streaming. Cutting the power supply strap will disconnect the on-board
power supply.

Tip:  Any connection that is cut can be reconnected using solder. Alternatively, a 0Ω 0402 resistor can be
mounted.

Tip:  When the debugger is disconnected, an external debugger can be connected to holes shown in 
Figure 8-6. Details about connecting an external debugger are described in 4.6  Connecting External
Debuggers.

Figure 8-5.  On-Board Debugger Connections Block Diagram
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Figure 8-6. On-Board Debugger Connection Cut Straps

GPIO straps (bottom side) Power Supply strap (top side)

8.5 Getting Started with IAR
IAR Embedded Workbench® for AVR® is a proprietary high-efficiency compiler not based on GCC. Programming and
debugging of AVR128DB48 Curiosity Nano is supported in IAR™ Embedded Workbench for AVR using the Atmel-ICE
interface. Some initial settings must be set up in the project to get the programming and debugging to work.

The following steps will explain how to get your project ready for programming and debugging:

1. Make sure you have opened the project you want to configure. Open the OPTIONS dialog for the project.
2. In the category General Options, select the Target tab. Select the device for the project, or if not listed, the

core of the device, as shown in Figure 8-7.
3. In the category Debugger, select the Setup tab. Select Atmel-ICE as the driver, as shown in Figure 8-8.
4. In the category Debugger > Atmel-ICE, select the Atmel-ICE 1 tab. Select UPDI as the interface and,

optionally, select the UPDI frequency, as shown in Figure 8-9.

Info:  If the selection of Debug Port (mentioned in step 4) is grayed out, the interface is preselected, and
the user can skip this configuration step.
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Figure 8-7. Select Target Device

Figure 8-8. Select Debugger
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Figure 8-9. Configure Interface
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The Microchip Website

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner and under normal

conditions.
• There are dishonest and possibly illegal methods being used in attempts to breach the code protection features

of the Microchip devices. We believe that these methods require using the Microchip products in a manner
outside the operating specifications contained in Microchip’s Data Sheets. Attempts to breach these code
protection features, most likely, cannot be accomplished without violating Microchip’s intellectual property rights.

• Microchip is willing to work with any customer who is concerned about the integrity of its code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code

protection does not mean that we are guaranteeing the product is “unbreakable.” Code protection is constantly
evolving. We at Microchip are committed to continuously improving the code protection features of our products.
Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act.
If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue
for relief under that Act.
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Legal Notice

Information contained in this publication is provided for the sole purpose of designing with and using Microchip
products. Information regarding device applications and the like is provided only for your convenience and may be
superseded by updates. It is your responsibility to ensure that your application meets with your specifications.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR
CONSEQUENTIAL LOSS, DAMAGE, COST OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or
expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox,
KeeLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PackeTime, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon,
TempTrackr, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology
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HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
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